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Preface
e/pop™ User Guide 
Preface
About This User Guide
Welcome to e/pop™, a real-time communications application from WiredRed 
Software that allows you to communicate with your co-workers instantly.  e/pop 
provides powerful capabilities such as instant messaging, chat and application 
sharing without a complicated setup or installation.  Working with your company 
network, e/pop is the ultimate application for communications in the office.

Audience
The intended audience for this guide is the user at the client level. Some material 
will be of interest to administrator as well.

Releases Covered in this Guide
This guide covers Release 3.0 of WiredRed’s e/pop client software.

What You Should Know
This guide assumes you have:

• Basic computer knowledge
• Experience using the keyboard and mouse
• Familiarity with Graphical User Interfaces (GUIs)
• An understanding of the Windows Operating System
• Familiarity with network protocols

What’s New
WiredRed’s e/pop 3.0 client software is the most comprehensive real-time 
communication product for collaboration.  The new version is delivered with new 
and improved features and functionality including:

• instant messaging
• status
• groups
• chat
• voice conferencing



How this Guide is Organized
e/pop 3.0 Client 
Table 1 lists a brief description of the new enhancements delivered with the e/pop 
3.0 client.

Table 1  
e/pop 3.0 enhancements

How this Guide is Organized
The basic user features and their tasks are described in this user guide and include 
the following:

• Instant Messaging
• Chat Conferencing
• Remote Control
• Application Sharing
• Remote Control
• Voice Conferencing

New Description

Locations - connect to your office e/pop 
system from any location 

The locations feature can connect to your office's e/pop 
server through any type of connection, from any 
location including a hotel, through firewalls, gateways 
and VPNs. 

Improved messaging Provides new functionality for selecting recipients 
while composing or forwarding messages. 

Improved macro, shortcut and message 
storage history features 

The macro, shortcut and message history features have 
been completely redesigned for improved performance 
and usability. 

Complete support for Internet 
connections 

e/pop's new routing architecture allows you to connect 
to your e/pop infrastructure using any type of 
connection (VPN, RAS and dial-up). 

Integrated voice conferencing system Provides both person-to-person voice chats or group 
voice conferences over your network. 

Improved support for client/server and 
peer-to-peer connections 

e/pop can operate in both peer-to-peer (P2P) mode as 
well as client/server for interconnecting over enterprise 
networks. Peer to peer supports IPX, TCP, UDP and 
multi-casting. 
xiv e/pop™ User Guide



How this Guide is Organized
Table 2 provides a brief description of each section of the e/pop User Guide.

Table 2  
User Guide Sections

Section Description

Preface Describes the organization of this User Guide, 
components, features and benefits of using e/pop.

Chapter 1: Getting Started with e/pop Describes installing e/pop, including requirements, 
program files, and steps for installing and starting 
e/pop on a local computer.

Chapter 2: e/pop and the Directory Describes the basic components of e/pop, including the 
main menu, the directory, basic features, and options.

Chapter 3: Using Instant Messaging This chapter describes sending and receiving instant 
messages.

Chapter 4: Using Chat Conferencing This chapter describes using chat conferencing. 

Chapter 5: Using Remote Control This chapter describes using the remote control feature 
of e/pop. 

Chapter 6: Using Application Sharing This chapter describes using the application sharing 
function of e/pop. 

Chapter 7: Using Voice Conferencing This chapter describes using the voice conferencing 
function of e/pop. 

Chapter 8: Options This chapter describes the options available for 
customizing e/pop client.
e/pop™ User Guide xv



Components and Features
Components and Features
The e/pop application includes the following components and features:

Table 3  
e/pop Components and Features

Feature Description

Status and Presence Automatically track the status and availability of co-workers using the 
status features of e/pop.  A variety of short status messages can be 
displayed including away-from-the-desk, online and offline and user-
specified messages.

Instant popup messaging Send and receive popup messages on your network.  Messages can be 
directed at individuals, groups, departments and network based objects.  
Frequently used messages can be converted into message macros.  One 
click message responses can be accomplished through the instant reply 
button feature.  Messages can be personalized with fonts, colors and 
graphics.

Text conferencing and chat Create conferences with co-workers in chat meeting rooms.  Multiple 
conference sessions can be operating simultaneously. Users can be 
selectively added or removed from the chat session.  Message 
conversation can immediately become a chat session.

Application sharing Share applications in a conference session for the purpose of 
presentations, demonstration or training.  Application sharing provides 
the ability for many people to view the same application program over 
the network and interact with the application in real-time.

Remote control Provide your support staff and help desk the ability to control the screen, 
keyboard and mouse of remote computers over the network with e/pop’s 
high performance remote control feature. 

Voice conferencing With e/pop's voice conferencing feature, you have the flexibility to set up 
a voice conference with your staff. Combine voice conferencing with 
application sharing and chat for training, presentations or brainstorming 
sessions.
xvi e/pop™ User Guide



Benefits of Using e/pop
Benefits of Using e/pop
Table 4 lists a brief description of the benefits you will enjoy using e/pop.

Table 4  
Benefits of using e/Pop

Directory integration with 
NetWare and NT/2000 Server

e/pop’s unique directory integration provides a network cross-platform 
solution that can communicate with objects on both NetWare and 
NT/2000 Domains simultaneously.  Status is automatically shown next 
to each user in their respective network directory.  For networks without 
a centralized server, e/pop provides it’s own internal User’s directory.

Options e/pop includes internal options that include: choices for sound, fonts and 
other specific preferences.

Benefits Description

Save time and increase 
productivity

Respond to co-worker and workgroup needs immediately.

Increase communication Enjoy instant messaging, group chats and application sharing.

Increase efficiency Help desk and support staff can diagnose problems quickly with the 
remote control and remote administration features.

Install easily Works on NetWare, Windows NT/2000 and Windows-based networks, 
requiring no additional server hardware.  e/pop automatically detects 
network information, simplifying implementation and administration.

Configure easily Build your own custom application with convenient Control Panel 
features and security.

Customize for optimal 
performance

Use the various Options to further enhance and customize your e/pop.

Control availability Use variety of status messages to communicate your availability to other 
e/pop users.

Ensure security Prevent unauthorized use of any features with e/pop’s integrated security 
features.

Table 3  
e/pop Components and Features

Feature Description
e/pop™ User Guide xvii



Additional Information and Support
Additional Information and Support

WiredRed Support
To contact support, please visit our web site at:

http://www.wiredred.com 

or send e-mail to:

support@wiredred.com 

WiredRed Sales
For sales and product ordering information, please visit our web site at:

http://www.wiredred.com

or send e-mail to:
sales@wiredred.com 
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Chapter 1: Getting Started with e/pop
This chapter describes installing e/pop, including requirements, program files, and 
steps for installing and starting e/pop on a local computer.

Requirements
To install e/pop you must have the following:

Hardware
• Pentium or better
• 8 MB RAM minimum

Operating System
• Windows 95, 98, NT 4.0, Windows 2000, or Windows ME

• Service Pack 3 and above for NT 4.0
• Updated COMCTL32 files from Microsoft (comes with Internet Explorer 4 and 

above) and can be downloaded from the WiredRed’s Web site

Minimum network configuration
• Network card (attached to a local area network)
• IPX/SPX or TCP/IP protocol installed

Application Sharing/Remote Control
• TCP/IP installed and configured 
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Program Files
Program Files
The e/pop application includes the following program files:

Table 1-1  
Installation Files

 

You can install e/pop into any directory you choose during the setup procedure.  The 
default installation directory for e/pop is the following:

C:\Program Files\Wiredred\Epop

File Description Required

LogonSvc.exe Nt/200 service for remote control 
of logon

No

EPop.exe e/pop application Yes

EPopCp.exe e/pop control panel No

EPopRem.exe application sharing module Yes

EPopRemC.dll application sharing DLL Yes

Radmin32.dll support domain APIs Yes

Rlocal32.dll support domain APIs Yes

Pop.wav message sound No

EPop.hlp Help files Yes

EPop.cnt Help files Yes

MyLocations.DAT personal location of file Yes

MyLocations.IDX personal location of file Yes

MyShortcuts.DAT personal shortcuts file Yes

MyShortcuts.IDX personal shortcuts file Yes

MyMacros.DAT personal macros file Yes

MyMacros.IDX personal macros file Yes

MyMacros.BLB personal macros file Yes
1-2 e/pop™ User Guide
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Uninstallation
Uninstallation
An entry will be added to the Add/Remove Programs feature of the Windows 
Control Panel.  You can uninstall the program by selecting the ‘e/pop’ listing in the 
Add/Remove Programs feature.

Also, you can uninstall the program by simply deleting the directory where e/pop is 
installed and running the XREG utility (available in the FAQ document on the 
WiredRed Web site) which removes any residual registry entries.  e/pop does not 
store files outside of the installation directory.

Installing on individual computers
To install e/pop locally on individual computers, do the following:

1. Insert the e/pop product CD into your CD-ROM drive.

2. Follow the directions in the dialog boxes on the screen.

3. If you are installing on more than one computer, you can copy the installation 
directory to other computers or to a shared directory on a file server.

Starting e/pop

Starting e/pop on local computers from Windows
e/pop is designed to automatically start when Windows is launched.  To start e/pop 
on a local computer from Windows, do the following:

1. From the e/pop menu, select the Options button.

2. Select the General tab.

3. Select Run when Windows starts and click OK.

The e/pop application adds the following information to the automatic run 
capabilities of the Windows’s registry:

[HKEY_LOCAL_MACHINE]
\SOFTWARE\Microsoft\Windows\CurrentVersion\Run\e/pop
e/pop™ User Guide 1-3
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Starting e/pop
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Chapter 2: e/pop and the Directory
The Main Menu
The Main Menu consists of the basic components of e/pop, including the menu, the 
Directory, Basic features, the Pull-Down menus, the Control Panel, and Options.

The following illustration details the menu functions you will use.

Figure 2-1  
2The Main Menu

The e/pop Directory
To display the Directory, click Directory on the e/pop tool bar. The Directory 
contains three kinds of objects: users, workgroups, and domains.  

• Users are individual users of e/pop.  
• Workgroups are created by users within the identity page of Options. A user 

may be included in more than one workgroup. 
• NT Domains objects are displayed in your e/pop directory if your system is 

logged into an NT/2000 Domain.  Your default domain and all user and group 
objects are displayed in the Directory for the default domain. 

• NDS Network objects display if your system is logged into a NetWare-based 
server and you are operating the Novell-supplied clients for NetWare.

My shortcuts

Change your 
status message

Auto reply

Do not disturb

Locations

The Directory is always 
accessible from the 
Directory button

Use the options 
menus to access 
basic features 
and options

Get messages
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The Objects in the Directory
Depending on your configuration of e/pop, the e/pop Directory displays the objects 
detected and the directory information that is accessible to you.  Every object 
displayed in the e/pop directory is an object that can be used with the various 
features provided.  It is important to understand the different objects and what they 
represent.

Figure 2-2  
2Directory Objects

Network Objects
Network objects are high level objects to represent everyone connected to a network 
of that type or included within a workgroup.  If you send a message to the ‘Users’ 
object in the directory, each person listed under the user’s workgroup receives your 
message.  Likewise, selecting ‘Domain’ sends a message to every person connected 
to any Domain that is operating the e/pop application.

NetWare NDS Network
NetWare NDS network objects display if your system is logged into a NetWare-
based network and you are operating the Novell-supplied clients for NetWare.  
Individual user objects are displayed within their respective containers.  Other 
objects are accessible as well, including groups and organizational units.  These 
objects represent more than one individual person.  They are extremely useful when 
you need to send a message to everyone under a specific object or everyone who is 
a member of a NetWare-based group.

Windows NT/2000 Domain Network
The Windows NT/2000 Domain network object displays in your e/pop directory if 
your system is logged into an NT/2000 Domain.  Your default domain and all user 

NT Domain Object

Workgroup Object

User Object
2-2 e/pop™ User Guide



Chapter 2 – e/pop and the Directory
The Objects in the Directory
and group objects are displayed in the Directory for the default domain.  You can 
also display additional trusted domains.  See the Domain section of the e/pop 
control panel for more information on specifying and enabling trusted domains.

e/pop obtains the information for the Domain from the domain controller.  Windows 
does not always locate the closest domain controller when retrieving objects for the 
domain.  It is recommended for Windows 95, 98, NT/2000 and ME that you use the 
e/pop Control Panel to specify the name of the local domain controller.  This is 
especially important when the local area network does not contain a PDC and only 
contains a BDC.

Group Objects
Using Group objects is a method of using a hierarchal tree organizational structure. 
e/pop can organize users under multiple tree-type objects at any level. Users can 
appear under various objects at different positions in the directory tree. This makes 
it possible to organize users by location, department and job classification.

Group management is both centralized (server level) and de-centralized (user level). 
By allowing de-centralized management, groups of users can organize themselves 
using the Workgroup creation feature.

Workgroup Objects
The User’s network provides workgroup objects that can be controlled by individual 
users of e/pop.  Workgroups allow users to organize themselves by departments or 
roles in an organization.

To add, delete, or modify a workgroup:

1. Select Options within e/pop.

2. Select Workgroups under the My Identity tab.

3. Click Add, Delete or Edit.

• To Add: Type in the name of the Workgroup, followed by .users, and click 
Add. (For example: accounting.users)

• To Delete: Select a Workgroup from the drop down menu and click Delete.
• To Edit: Select a Workgroup from the drop down menu and click Edit.

4. Click OK.

Departments can opt to indicate their own workgroups to easily identify themselves 
in the e/pop User’s Directory.  Workgroups can contain ‘periods’ to create multiple 
level objects. (e.g., us.accounting)
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User Objects
A user object represents a user on the network. Each user has a unique identifying 
name or ‘identity.’ The identifying name can be any of the following:

• User’s login name
• User’s machine name
• User’s full name from NDS or the NT/2000 Domain
• User’s specified identity from Options

A user’s identity is displayed under each workgroup specified for the user.

User’s Network  
The User's network is the built-in network of the e/pop program.  It is an automated 
list of users who are running the e/pop program.  It is the primary network of peer-
only environments, where a central file server is not utilized.  The User's network is 
a robust system, providing the users the ability to create workgroups and complex 
departmental trees to organize all the e/pop users.  Using the User's network, you 
can indicate that people are part of certain departments or locations, and have those 
individual e/pop users appear under the respective workgroup in the Directory.

How Users are Displayed
By default, the e/pop directory displays a user under each network the user is logged 
into.  For example, if user Allen logs into an NT/2000 Domain, his name is 
displayed under both the Users network and the NT/2000 Domain network.  This 
behavior can be controlled with the e/pop Control Panel.

Figure 2-3  
2Example of how a user 
is displayed

The e/pop directory can display a user with a combination of Login Name, Identity 
and Machine Name.  These choices can be controlled using a combination of 
Options and the e/pop Control Panel.
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To change your unique identity:

1. Select Options

2. Select My Identity tab

3. Type in the desired name under My Identity.

4. Click OK. 

The e/pop Name 
The e/pop name identifies each distinct object and tells e/pop where it is located in 
the directory. Objects can be preceded by an object type specifier such as W= 
(workgroups) and D= (domain) for groups. User objects are not preceded with a 
type.

Figure 2-4 shows the name of a e/pop directory object.

Figure 2-4  
2e/pop name example

Using the My Shortcuts Folder
My Shortcuts folder creates easy access to Directory objects by organizing them in 
a way that is convenient for you. You can create your own personal or nested 
groups.  My Shortcuts folder can act as your own personal list of users and groups.

Access your folder by clicking the My Shortcuts button on the 
e/pop main screen. 

Adding Objects to My Shortcuts Folder
You can add user or group objects to your My Shortcuts folder by: 

1. Select the object in the Directory.

2. Right-click and select Add to My Shortcuts.

Note:   When you copy a group object to your My Shortcuts folder all objects will 
be listed individually and not as a group in the folder.
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Deleting Objects From My Shortcuts Folder
You can delete user or group objects from your My Shortcuts folder.

• Select the object in the My Shortcuts folder. (To select more than one object, 
hold down the Ctrl key.) Delete the object(s) using one of the following:
• Right-click and select the menu option Delete. 
• Select Edit > Delete from the Main Menu.
• Press the Delete key.

Creating a Personal Group
To create a Personal group do the following:

1. Select My Shortcuts button from the Main menu.

2. Right-click and select New > Personal Group from the drop-down menu.

3. Rename the New Personal Group using one of the following:

• Right-click and select the menu option Properties 
• Right-click and select the menu option Rename or
• Select Edit > Rename from the Main Menu or press <F2>

Adding Objects to a Personal Group
To add objects to a Personal group do the following:

1. Select object(s) 

2. Drag and drop into the Personal Group 

Note:  Objects to be added to the Personal Group must already reside in the My 
Shortcuts folder.

Creating a Nested Personal Group
To create a nested a Personal Group do the following:

1. Create multiple Personal Groups.

2. Select personal group to be added

3. Drag and drop into the Personal Group 

4. Rename the New Personal Group using one of the following:

• Right-click and select the menu option Properties 
• Right-click and select the menu option Rename or
• Select Edit > Rename from the Main Menu or press <F2>
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Setting up your Locations
There are several location options for running e/pop client, which includes:

• Direct connection to server
• Dial-up RAS connection to server
• Dial-up networking connection to server
• Peer to peer (P2P)

When you start e/pop client for the first time you will receive the message in Figure 
2-5. e/pop has detected a server on your network. 

• Answer Yes, and your system will close e/pop (click on the e/pop icon to restart 
and e/pop will connect with the detected server).

• Answer No, and e/pop is activated on your system in the peer-to-peer mode. To 
set a default location or add and delete a location use the Locations button.

Figure 2-5  
2Location Message

Using the Locations Button

From the Directory tool bar, use the locations button  or select the location from 
a Edit pull-down list (refer to Figure 2-6) and to one of the following:

• Select a new location.
• Add, Delete or Rename a location.
• Click the Connect button to connect to the new location.
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Figure 2-6  
2Locations

• Click the Properties button (see Figure 2-6) and the Properties menu will 
appear (see Figure 2-7). You can specify the IP address of the server and 
connection type for your e/pop client location, and

• Specify the general options and preferences for your e/pop location.
• Always check for new instant messages - Automatically checks for new 

messages when e/pop starts.
• Always send keep alive sequences - Periodically polls the server to maintain 

a connection to networks where inactivity can cause a time-out.

Figure 2-7  
2Properties menu
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Using the Do Not Disturb button

Use the Do Not Disturb button  available from the Main menu to change your 
status in the directory from available to privacy.

Figure 2-8  
2Using the Do Not 
Disturb button

The Do Not Disturb button will remain depressed  until you select it changing 
you status from Privacy to Available.

Using the Auto Reply button

Use the Auto Reply button  from the Main menu to set your e/pop to 
automatically send a reply about your status. To set up Auto Reply options:

• The Auto Reply menu will appear, you have three options:
• Select Add - the Add Auto reply menu will appear. Type the message you 

want to be sent out when Auto Reply is enabled. For example: ‘I am away 
from my desk.’ Click OK.

• Select Delete - from the drop-down, select the message you want to delete. 
Click Delete, click OK.

• Select Edit - from the drop-down, select the message you want to edit. Click 
Edit, modify the message and click OK.

Enabling Auto Reply
To enable the Auto Reply select the drop down beside the Auto Reply button (see 
Figure 2-

Figure 2-9  
2Enabling Auto Reply

Status using Do Not 
Disturb button 
(yellow icon)

Directory object with 
available status 
(green icon)

Auto Reply message

Auto Reply Drop down
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Using the Status button

Use the Status button  from the Main menu to set your e/pop personal status 
messages. To set up your status messages you will use to change your status in the 
directory, click the Status button and:

• The Status menu will appear, you have three options:
• Select Add - the Add Status reply menu will appear. Type the message you 

want to be sent out when Auto Reply is enabled. For example: ‘I am away 
from my desk.’ Click OK.

• Select Delete - from the drop-down, select the message you want to delete. 
Click Delete, click OK.

• Select Edit - from the drop-down, select the message you want to edit. Click 
Edit, modify the message and click OK.

Using your personal status messages
To use the your personal status messages select the drop down beside the Status 
button and select the status message from the list (see Figure 2-10)

Figure 2-10  
2Using your personal 
status messages

Specifying the Default Features
Out of the box, e/pop is configured for ‘message’ as the default feature. Figure 2-11 
illustrates the directory default settings as delivered in e/pop.

Personal status messages

Default status messages

Current Status

Status Drop-down 
button
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Figure 2-11  
2Directory options

You can change the default feature to chat, remote control or any other e/pop 
feature.

1. Select Options.

2. Select the Directory tab.

3. Select a default feature from the drop down menu. Note: When a feature is 
selected you can double-click on a directory object to start the feature and invite 
participants.

• Message (Default, enabled when application is installed)
• Chat 
• Remote Admin
• Remote Control
• AppShare
• Voice Conference

4. Click OK.

For example, if you specify Message, the Instant Messaging compose window 
appears when you double-click on an object in the Directory.
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Basic e/pop Features
The basic user features include the following:

• Instant Messaging
• Chat Conferencing
• Application Sharing
• Remote Control
• Voice Conferencing

The Pull-Down menus
Use the pull-down menus to access the features available in e/pop. Table 2-1 is a list 
of the pull-down menus and what the menus include:

Figure 2-12 illustrates the Actions drop-down menu.

Table 2-1  
Pull-down menus

Pull-Down menu Actions Available

File New Message Macro
Exit

Edit Cut
Copy
Paste
Delete
Rename
Locations

Action Message
Chat
Remote Admin
Remote Control
App Share
Voice Conference
Options...

Help Contents and Index
Control Panel
About e/pop
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Options
Figure 2-12  
2Drop-down Actions menu

Options
Use Options to customize e/pop for your own personal preferences. These include 
network protocols, status display messages, fonts, how e/pop runs and exits, 
confirmation messages, storing messages, sounds and much more. Figure 2-13 
shows the Options menu, Table 2-2 gives a brief description of each option tab.

Figure 2-13  
2Options

.

Table 2-2  
e/pop Option tabs

Option Description

Network Network and protocol settings

My Identity User identification and workgroup 
settings

Contact User’s contact and e-mail information

General General operation and client options

Status Information displayed for status 
messages

History Preferences for storage of personal 
messages
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Features Specifies which features are enabled for 
your computer

Do Not Disturb Preferences for chat and messages when 
‘Do not disturb’ is activated

Remote Control Preferences for remote control options

AppShare Preferences for application sharing

Locations Preferences for whether location is 
automatic at startup, or prompted

Messages Preferences for displaying messages

Chat Preferences for chat sessions

Fonts Preferences for display of messages, 
chats, and Directory

Sounds Preferences for sounds played for new 
messages and chat sessions

Directory General preferences for the Directory

My Files Location for storing personal history, 
shortcuts and macros.

Table 2-2  
e/pop Option tabs

Option Description
2-14 e/pop™ User Guide



Chapter 3: Using Instant Messaging
e/pop™ User Guide 3
-1
Chapter 3: Using Instant Messaging
This chapter describes sending and receiving instant messages, including:

• adding or removing recipients, 
• adding file attachments, 
• customizing messages with fonts, graphics and macros, and 
• forwarding and storing messages. 

Figure 3-1 illustrates the e/pop window with messaging.

Figure 3-1  
3Messaging

Compose icon
Select to compose a
new message

Inbox folder stores
incoming messages

Sent items folder 
stores messages
you have sent

Deleted items folder
stores message 
you have deleted
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Sending a message
You can compose and send a new message by following three basic steps:

    Step 1   Select a Directory object (such as an individual user or a workgroup).

    Step 2   Enter information in the message composition window.

Step 3 Click Send button.

Step 1 – Selecting a directory object
Select a Directory object by using one of the following options in Table 3-1.

Note:  Out of the box, e/pop is configured for ‘message’ as the default feature. 
Refer to Chapter 2, Figure 2-3 illustrates the directory default settings as 
delivered in e/pop.

Step 2 – Entering information in the message window
After you have selected the Directory object(s), enter information as necessary in 
the displayed message composition window (refer to Figure 3-2).

Table 3-1  
Message options

Option Action

1 Double-click on the Directory object (if message is the 
default action).

2 Right-click on the directory object and choose Message 
from the submenu.

3 Select an object in the directory and click the Compose 
icon from the window pane on the left. 

4 Select an object in the directory and select Message from 
the Actions menu. 
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Figure 3-2  
3Message composition 
window

Adding recipients
To add recipients in the To: field, do one of the following:

• Click the To: button  and select a recipient and
• Click the Add button to add the recipient or
• Click the Delete button to delete the recipient

• Select all objects from the Directory before composing a message, or
• Select objects from the Directory and then Edit, Copy from the menu.  Within 

the To: field of the message, right-click and select Paste, or
• Drag and drop an object from the Directory or from a My Shortcuts folder into 

the message window. To move more than one object at a time, hold down the 
Ctrl or Shift keys.

Figure 3-3  
3Adding a recipient
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Deleting recipients
To delete recipients from the To: field:

1. Highlight the recipient in the To: field.

2. Press the Delete key.

Requesting a Return Receipt 
To request a return receipt when sending a message:

• Click on the Receipt button on the tool bar (the button remains depressed).

When the recipient receives your message, a return receipt confirmation is sent to 
your Inbox folder.

Attaching files to a message
To attach a file when sending a message:

1. Click on the Add attachments button on the tool bar.

2. Select a file you want to attach (you can select more than one).

3. Click on the Open button.

A list of file attachments is displayed at the bottom of the message.  

Note:  Attachments are limited to 1.5MB in peer mode and unlimited in size when 
using an e/pop server.

Deleting an attached file
To delete a file you have attached to a message:

• Select the file you want to delete from the list at the bottom of the message and 
press the Delete key.

Customizing text in a message
You can customize your text by changing fonts and font style, size and color. 
Simply select the text the apply the attributes.

Figure 3-4  
3Tool bar for customizing text 
messages

Font name                      Font size           Font style         Alignment    Bullets       Color
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Adding images to messages
You can send images with your messages as file attachments, or you can paste them 
directly into the text of your message. To add an image directly:

1. Copy the image you want to add.

2. Paste it into the message.

Note:   To embed images into messages, you must first enable this feature using the 
e/pop Control Panel feature called ‘Enable pasted bitmaps in messages.’

Adding Quick Reply buttons
You can send a message with multiple pre-defined quick reply buttons. When the 
recipient receives the message, the recipient can click the Instant Reply button to 
immediately reply to your message. To add the buttons to your open message:

1. Click on the Instant button  on the tool bar of the message window.

2. Click on the Add Instant Reply button at the bottom of the message.

Figure 3-5  
3Add Instant Reply button

3. Type in the reply message that you want to appear on the button. 

4. Click OK.

The Instant Reply button messages will be added to the right of the Add Instant 
Reply button at the bottom on the message screen.

Figure 3-6  
3Instant Reply buttons

Note:   You can optionally convert these composed messages and instant reply 
buttons into message macros.  These message macros can act as templates for 
common message communication.  See the section on message macros for 
further information.
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Exporting a message
You can save a message in Rich Text Format (RTF) to another location on your 
drives or network.

1. Click on the Export button.

2. Select a location and type in a new filename.

The new file is saved with an .RTF extension.

Importing a message
You can import a Rich Text Format (RTF) file from another location on your drives 
or network.

1. Click on the Import button. 

2. Select a location and the RTF file to import.

Receiving messages
By default, e/pop is configured so that:

• All received messages pop up automatically on the screen.
• A copy of the message is stored in the Inbox folder.

Changing the way you receive messages
You can change the way e/pop displays new messages when you receive them.

1. Click on the Options button. 

2. Select the Messages tab.

3. Select the preference from Table 3-2 according to your requirements.

4. Click OK.

Table 3-2  
Preferences for receiving 
messages 

Select Preference How Message is delivered

Always show (default) New messages pop up on your screen.

Always show inactive New messages do not pop up but display on the 
Windows task bar.

Always prompt before show Confirmation message prompts you before 
displaying the message.
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Replying to a message 
To reply to the sender or the sender and all CCs:

• Click on the Reply (the sender) or Reply to All (send to 
all) button on the tool bar.

The original message closes and a new message box opens, which includes the text 
of the original message.

Auto Reply Message 
If Auto Reply is enabled, the message selected will be displayed in the body of 
message when you click the Reply button. “Auto Reply’ will flash at the top the 
message window.

Forwarding a message
To forward a message while viewing the message:

1. Click the Forward button on the tool bar.

2. To select the recipients for the message click the To: button  and select 
a recipient and click the Add button.

Always hide New messages do not pop up but are stored in the 
Inbox folder.

Flash when a message 
arrives

The tray icon or the text on the message window and 
the text on the tool bar flash when a new message 
arrives.

Show new message on top of 
other applications (Default: 
Enabled)

New messages stay visible on top of other 
applications until you close the message window.

Retain return receipt button 
state (Default: Disabled)

Retains the state of the return receipt button from the 
last time you created a message.

Windowed Message windows can be displayed in a separate 
window for each message or within a single 
window, with a previous and next button to scroll 
between messages. Select either Single Window or 
Cascade Window.

Table 3-2  
Preferences for receiving 
messages 

Select Preference How Message is delivered
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Note:   While most information related to the message is forwarded to the 
recipients, attachments are not included.

Storing messages
By default, e/pop stores messages in the Inbox, Sent Items, and Deleted Items 
folders only while it is running. These messages are permanently deleted when you 
exit e/pop.  You can store a history of messages in your Inbox, Sent Items and 
Deleted Items folder. 

To enable the storage feature:

1. Select Options.

2. Select the History tab.

3. Click ‘Enable History.’

Note:  When changes to this option are implemented, e/pop has to be restarted for 
the changes to take effect.

Retrieving messages
To retrieve a message from the Inbox, Sent Items or Deleted Items folder:

1. Click on the appropriate folder icon to open it.

2. Select the message to be retrieved.

3. Double-click on the message. 

Deleting a message
To delete a message from the Inbox, Sent Items or Deleted Items folder: 

1. Click on the appropriate folder icon to open it.

2. Select the message to be deleted.

3. Press the Delete key on your keyboard or select Delete from the Edit drop-down 
menu.

Note:  •If in the History Option ‘Show delete button on the tool bar,’ (by default this 
item is disabled) is enabled, the delete button will appear when selecting items 
in a history folder. You can select the item to be deleted and press the Delete key 
on the tool bar.
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Printing a message
To print a message while viewing the message:

• Click on the Print button on the tool bar .

Using Message Macros
Message macros are instant message templates that you use often and can customize 
for specific communications.  Message macros are stored internally for easy access 
and modification.  This section describes the following:

• creating new macros 
• setting up and using message macros 
• editing macros 
• adding quick reply buttons

Creating a New Message Macro
You can create a new message macro in two ways:

1. Creating the message macro while composing a new message, or

2. Selecting File > New Message Macro.

Creating a Macro for a New Message
To create a message macro for a new message:

1. Right-click a Directory object and select Message, or double-click on the object.

2. Enter information as necessary in the Message window.

3. Clickl the Macro button on the Message tool bar. 

4. Enter the name for the macro into the Create Macro window.

5. Click OK.

The message macro button will be added to the Main window. The saved macros 
will be added to the right of the macro button on the tool bar.
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Creating a New Message Macro
To create a macro do the following:

1. Select File > New Message Macro.

2. Enter the name for the macro into the Create Macro window. 

3. Click OK.

4. Enter information as necessary in the Message window.

5. Click the Update button on the Message tool bar. 

The message macro button will be added to the Main window. The saved macros 
will be added to the right of the macro button on the tool bar.

Editing an Existing Macro 
To edit and update a macro, access the macro using one of the following.

1. Click on the Macro button from the Main menu.

2. Select Edit and the Edit Macro menu appears.

3. Select the macro to edit from the drop-down and click OK.

4. Make your changes.

5. Click the Update button.

Deleting an Existing Macro 
To delete a macro do the following: 

1. Select Macro > Delete from the Main menu tool bar, the Delete Macro window 
appears.

2. Select the macro to be deleted from the Delete Macro window drop-down.

3. Click OK.

Repeat steps one and two until you have deleted the necessary macros.
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Chat Conferencing Features
This chapter describes using chat conferencing. With this feature you can establish a 
real-time chat session with multiple computers across a network. You can converse 
with one or more users, or a group of users simultaneously. e/pop chat conferencing 
includes the following features:

Table 4-1  
Chat Features

Chat Icon Chat Feature Description

New Clears the contents of the chat session.

Export Saves and exports a chat session in RTF 
format.

Print Prints the chat session comments

Copy Copies text from the chat session to the 
Windows clipboard.

Float Forces chat window to always be in 
front of other applications.

Hide System Hide or show the system related mes-
sages for the chat session.

Rotate Rotates the position of the chat session 
and the user’s listing between horizontal 
and vertical.

Expand Users Expands user lists so you can view text 
as users type their messages.

Private Message You can send a private message to 
another user or users in the same chat 
session while you are participating in 
another chat session.
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Private Chat Start a private chat session.

Grant Moderator The person who initiates the chat session 
is the moderator of the chat session. 
Moderators have special privileges and 
can perform the following functions:
• Invite other users to join the chat 

session
• Expel users
• Give other chat participants 

privileges to invite others
• Assign other users as moderators.

Grant Add Participants The moderator uses this button to grant 
permission to other chat participants to 
invite others to join.

Private Room/Public 
Room

Chat room at initiation is private. The 
moderator uses this buttonto change the 
private chat room to a public chat room.

Set Password Used to set a password on the chat room 
session.

Expel Expels a user from a chat session.

Leave All Completely closes the chat session for 
all participants.

Room Title Changes the title of the chat room.

Table 4-1  
Chat Features

Chat Icon Chat Feature Description
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Starting a chat session
To start a chat session:

1. Select the Conference button.

2. Select the object(s) from the directory to participate in the chat session.

3. Click the Chat icon or right-click and select Chat from the pull-down menu.

Figure 4-1  
4Starting a Chat session

Chat Icon

Chat rooms

Conference button
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Chat Session Window
The chat session provides an interactive conversation between all recipients.  To 
type a response into the chat session, use the field at the bottom of the chat window 
(refer to Figure 4-2). 

Figure 4-2  
4Chat Session window

Status window

Text chat window for 
viewing session 
messages

Text window for 
composing and sending 
chat messages

Status of chat 
participants (in 
blue while user 
is typing)
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Granting privileges to users
The moderator of a chat session can grant two types of privileges to other users:

Grant Moderator
The moderator has the following permissions:

• grant another participant moderator privileges
• grant add participants
• change chat from private to public
• set a chat session password
• invite and expel users
• change the room title
• close the chat session for all participants.  

These privileges are the same for all chat session moderators.

Grant Add Participants 
This is a special privilege which allows certain chat session participants to invite 
others into an already active chat room.

To assign privileges to a participant:

1. Right-click a user or users.

2. Select Grant Moderator or Grant Add Participants.

Change Chat Session to Public
The moderator can change the private chat room to a public chat room. To change 
the session do the following:

1. Select and click on the Private Room button . 

2. The button will change to signify the private chat room is now public chat room 
with the addition of the sphere (ball)  .

Once the chat room is a Public room, everyone on the network can view the 
chat and join. You can change the chat room back to a Private chat room by 
clicking on the button (the ball will disappear).

Note:   The sphere (ball) indicates that the chat room is available over the network.
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View the status of each user
All users within the same chat session are displayed in a list along with their chat 
status. Status tells you if a user is:

• actively participating in (or viewing) a chat session 
• user’s chat window is closed, or 
• user is in the process of responding.

You can view the status of other users in your chat session and see what they are 
typing.  When a user in a chat session starts typing, his or her name displays in blue.

To view text as a user types:

• Click the Expand Users button

Change the view of the chat windows
You can customize your view of the chat session with the various options on the 
chat tool bar.  The options include:

• rotating the window, and 
• displaying the system related chat messages.

Rotate 4Changes the position of the chat session and the user’s listing between 
horizontal and vertical. Figure 4.2 illustrates the default position of the chat 
window. “Status of Chat Participants” is not part of the window when rotated.

Figure 4-3  
4Chat window using 
Rotate option

Text window for 
composing and sending 
chat messages

Status window of 
system messages

Text chat window for 
viewing session 
messages
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System messages for the chat session
When system messages are activated, the chat session displays the activity in the 
chat room, such as User A just joined the chat room or User B has been expelled. 

You can use the Hide System button  from the chat window tool bar to turn this 
option on and off during the chat session.

Inviting a user into a chat session
You can invite additional participants into an already active chat room provided you 
have either ‘moderator’ or ‘add participant’ privileges to the chat session.

To invite a user into the chat session:

1. Select the object(s) from the directory.

2. Drag the object(s) and drop them into the chat room.

Expelling a user from a chat session
You can expel a user from a chat session provided you are a moderator. Once 
expelled, a user cannot return unless invited back by a moderator or a user with add 
participant privileges. Moderators cannot be expelled from a chat room.

To expel a user from the chat session:

1. Select the user in the chat session user listing.

2. Click the Expel button  on the tool bar.

Sending a private message
You can send a private message to another user in the chat room while you are 
participating in a chat session.

To send a private message:

1. Right-click on a user or a group of users.

2. Select Private Message

Starting a private chat session
You can start a private chat session with a user or a group of users while you are 
participating in a chat session.

To start a private chat session:

1. Right-click on a user or a group of users.

2. Select Private Chat.
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Exporting a chat session
You can save and export a chat session in Rich Text Format (RTF) to a file.

To export a chat session:

1. Click the Export button .

2. Specify a location for the .RTF file.

Customizing chat conferencing
You can use the e/pop Options to customize chat conferencing for your individual 
preferences.

To customize chat conferencing:

1. Click the Options button.

2. Select the Chat tab.

Figure 4-4 illustrates the default options. You can select the following types of 
options.
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Customizing chat conferencing
Chat Options
You can customize a chat session using the Chat options to set display preferences 
when you are invited into a chat session or when a new message is posted to a chat 
session in which you are participating. Refer to Table 4-2 for the features below and 
additional features in the Options menu.

Figure 4-4  
4Chat options menu
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Customizing chat conferencing
Table 4-2  
Chat Options

Option Tab Selection Description

Chat Sessions Select the display of new chat sessions using one of the following:
• Always show (default)
• Always show inactive
• Always prompt before showing
• Always hide

Chat Messages Select the display of new chat messages using one of the following:
• Flash when a chat message arrives (default)
• Show new chat session on top of other applications (default)
• Show date and time on chat messages
• Show chat window for each chat message
• Confirm close chat room when moderator leaves (default)

Directory Feature Select ‘Chat’ and chat will be the default feature when clicking on 
an object in the directory.

Do Not 
Disturb

Chat Specify the following when ‘Do Not Disturb’ is activated:
• Hide new chat sessions (default)
• Prevent chat sounds from playing

Features Chat When you select Chat in the option tab, chat is enabled and can be 
used on your computer. (default)

Fonts Chat Use the Fonts option to specify the fonts used by chat:
• Sent text
• User names
• Received text
• System Messages
• User Listing

Sound Chat Use the Sounds option to specify the sound to play for new chat 
sessions or receiving a chat message.
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Chapter 5: Using Remote Control
This chapter describes using the Remote Control feature of e/pop.  The remote 
control feature allows you to control the screen, keyboard and mouse of other 
computers on your network.  You can diagnose and assist in problem resolution 
from a remote location using the Remote Control feature. Figure 5-1 illustrates the 
location of the remote control icon.

Figure 5-1  
5Remote Control Feature

Starting Remote Control
You can start Remote Control in one of these ways:

• Click the Admin button and then the Remote Control icon in the left window.
• Select Remote Control from the Actions Menu.
• Right-click a user in the Directory and select Remote Control or press Ctrl T.

Note:  You can also double-click on a user in the Directory if Remote Control has 
been set as the default task (Options, Directory, Remote Control).

Remote Control
Icon
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Remote Control Viewer
Remote Control Viewer
The remote control viewer provides a window into a host computer.  When your 
mouse moves over the viewer area, it changes the mouse location on the host 
computer.  To exit the remote control session, simply click the Close button in the 
upper right corner of the window.

Figure 5-2  
5The Remote Control Viewer
5-2 e/pop™ User Guide



Chapter 5 – Using Remote Control
Using the Tool bar Buttons
Using the Tool bar Buttons
Use the following tool bar buttons during a remote control session.

Table 5-1  
Remote Control buttons

Icon Name Function

Connect Connects or disconnects from the host IP

Host IP IP address of the host computer

Refresh Refreshes the viewer’s screen to match the host 
computer’s screen.

Stretch Enabling this option reduces the size of the viewer 
window to fit in a smaller window.

Auto Scroll Enabling this option causes the viewer to automati-
cally scroll when the mouse moves to the edges of 
the viewer window.  It is used when the host com-
puter’s video resolution is greater than the client’s.  

Controls Toggles control of the mouse and keyboard during a 
remote control session.

56KB High compression, low quality image designed for 
56K lines.

1.5MB Medium compression, medium quality image 
designed for T1 or greater lines.

10MB Low compression, high quality image designed for 
local area networks.

Send Ctrl-Alt-Del

About
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Remote Control Performance
The remote control capabilities of e/pop are among the fastest available.  If you are 
experiencing a delay with remote control, it is important to determine if there is a 
performance issue with the card of either the host computer or the client computer 
(the machine you are using). 

A poor video benchmark is usually the result of:

• non-accelerated video card, or
• insufficient video memory, or
• video drivers that are out of date, or
• video color resolution conversion.

The closer the video resolution matches between the host and the client, the quicker 
the remote control session operates.  When the color resolution of the machines do 
not match, the program must convert the colors, which slows the remote control 
process.

Automatic Screen Refreshes
Most applications automatically transmit their real-time changes to the viewer of 
the remote control session.  However, some applications use special techniques that 
do not refresh the viewer.  In these cases you can control whether or not the screen 
refreshes and how often these updates occur.

To activate the automated screen refresh option:

1. Click the Options button.

2. Select the Remote Control tab.

3. Click ‘Refresh screen every X milliseconds.’
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Chapter 6: Using Application Sharing
Overview
This chapter describes using the application sharing function of e/pop. Application 
sharing allows two or more users to view and interact with an application running 
on a host computer.

With e/pop’s application sharing feature, you can set up an application on a 
networked host computer and share it with one or more users on client computers. 
The host computer can be your own computer or a remote computer. The initiator of 
the application sharing session is given moderation privileges and can grant 
keyboard and mouse control to specific participants.

Figure 6-1  
6Typical application sharing 
configuration

Application sharing can be used for the following:

• train employees, 
• give presentations with participants from various locations, or 
• remotely provide software support.

Application sharing can be combined with the following to add interaction between 
the host and participants.

• Instant messaging
• Chat conferencing
• Voice conferencing

Host Computer

Client 
Workstations
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Requirements
Requirements
Application sharing and remote control are dependent upon the quality of the 
hardware in the host computer.  To run application sharing, you should have the 
following:

Host computer hardware
• Pentium computer
• AGP/PCI Graphic Accelerator Card 
• Updated video drivers

Host computer software
• Windows 95, 98, NT/2000 or ME
• e/pop 3.0 installed and operating
• TCP/IP as the default protocol

Starting Application Sharing
To set up an application sharing session on your own computer, do the following:

1. Start the application you want all participants to view. (For example: Microsoft 
Word, presentation, or other software application.) Refer to Figure 6-2.

2. Select the Conference button.

3. Select yourself and the directory objects that you want to include on the voice 
conference session from the Directory.

4. Start Application Sharing using one of the following:

• click on the AppShare icon, or 
• right-click and select AppShare from the drop-down menu, or
• select AppShare from the Actions pull-down menu.

5. Click Make Appshare Host button .

6. Invite other users to the application sharing session by:

• Select objects from the Directory and drag and drop the object(s) into the 
AppShare participant’s window. 
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The AppShare Viewer
Figure 6-2  
6Starting Application Sharing

The AppShare Viewer
The AppShare Viewer is the window into the host computer.  Each participant in the 
application sharing is provided a viewer to examine the real-time contents of the 
session.

Application sharing 
icon

Conference Button

Application sharing 
drop-down menu
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AppShare Participants Window
Figure 6-3  
6AppShare Viewer

Inviting Users
To invite a user into an application sharing session, do the following:

• Select objects from the Directory and drag and drop the object(s) into the 
AppShare participant’s window. 

Expelling Users
To expel a user from an application sharing session, do the following:

1. Select a user in the AppShare participants window.

2. Click the Expel button on the tool bar.

AppShare Participants Window
Figure 6-4, the AppShare participants window displays all the users who are 
participating in the application sharing session.  You can invite additional 
participants by selecting them from the Directory and drag and drop them into the 
participant’s window.

AppShare Host

Application being 
Shared
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AppShare Participants Window
Figure 6-4  
6AppShare window

Controlling Access to the Keyboard and Mouse
The moderator of the application sharing session can grant or restrict access to the 
mouse or the keyboard.  By default, the moderator is the only participant with 
mouse and keyboard control of the host.

To grant control access to keyboard and mouse:

1. Select a user or users in the AppShare participants window.

2. Click the Controls On or  Controls Off  button on the tool bar.

• Selecting Control On provides access to the keyboard and mouse.
• Selecting Control Off removes keyboard and mouse access.

Note:  When the Control On button is applied to a participant a ball (sphere) will be 
added next to the participants the icon to indicate access. Selecting the Control 
Off will remove access and the ball (sphere) will be removed.

Sending a private message
You can start a private chat session with another user or users in the same chat 
session while you are participating in a current chat session.

To send a private message:

1. Select a user or users in the AppShare participants window.

2. Click on the Private Message button  on the tool bar.

AppShare window with 
Host, all buttons are 
active

Participant’s AppShare 
window, control buttons 
are not active (grayed-
out)
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Starting a private chat session
You can start a private chat session with another user or users in the same chat 
session while you are participating in a current chat session.

To start a private chat session:

1. Select a user or users in the AppShare participants window.

2. Click on the Private Chat button  on the tool bar.

Automatic Screen Refreshes
Most applications automatically transmit their real-time changes to the viewers of 
the application sharing session.  However, some applications use special techniques 
that do not refresh the viewers.  In these cases you can control whether or not the 
screen refreshes and how often these updates occur.

To activate the automated screen refresh option:

1. Click the Options button.

2. Click the AppShare tab.

3. Click ‘Refresh screen every X milliseconds.’

Hosting Application Sharing on a Remote Computer
You can dedicate computers on your network for application sharing purposes.  
These machines can act as hosts for anyone on the network.  To host application 
sharing session on a remote computer:

1. Select a remote computer or workstation to host the application sharing session 
from the Directory.

2. Start the application you want all participants to view. (For example: Microsoft 
Word, presentation, or other software application.) Refer to Figure 6-2.

3. Select the Conference button.

4. Start Application Sharing using one of the following:

• click on the AppShare icon or 
• right-click and select AppShare from the drop-down menu, or
• select AppShare from the Actions pull-down menu.

5. Click Make Appshare Host button .

6. Invite other users to the application sharing session by:

• Select objects from the Directory and drag and drop the object(s) into the 
AppShare participant’s window. 
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Chapter 7: Using Voice Conferencing
Overview
This chapter describes using the voice conferencing function of e/pop. Voice 
conferencing allows two or more users to communicate real time through a host-
networked computer.

With e/pop's voice conferencing feature, you can set up a voice conference on a 
networked host computer and share it with one or more users on client computers. 
The host computer can be your own computer or a remote computer. The initiator of 
the voice conference session is by default the "hub" or relay of the session. All 
conversation is routed through the host computer and out to all session participants.

Figure 7-1  
7Example of voice 
conferencing

Voice conferencing can be used for the following:

• train employees, or
• online meetings with participants from various locations, or
• provide software support remotely.

Voice conferencing can be combined with the following to add interaction between 
the host and participants.

• Instant messaging
• Chat conferencing
• Application sharing

Host Computer

Client Computers

User 2 User 3

User 1 User 4
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Requirements
Requirements
Voice conferencing is dependent upon the quality of the hardware/software in the 
client computer.  To run voice conferencing, you should have the following:

Host computer hardware
• Pentium recommended
• Sound Card 
• Speakers
• Microphone
• Current drivers for your sound card

Host computer software
• Windows 95, 98,  NT/2000 or ME
• e/pop 3.0 installed and operating
• e/pop 3.0 voice conferencing
• TCP/IP as the default protocol

e/pop Voice Conferencing Software
The e/pop voice conferencing software is not delivered with the e/pop software. If 
you want to use the voice feature, you will need to download the executable file 
from the WiredRed Web site.

http://www.wiredred.com

Install e/pop voice conferencing executable into the directory you choose during the 
setup procedure.  The default installation directory for e/pop is the following:

C:\Program Files\Wiredred\Epop
7-2 e/pop™ User Guide



Chapter 7 – Using Voice Conferencing
Starting Voice Conferencing
Starting Voice Conferencing
To start a voice conference session on your own computer, do the following:

1. Select the Conference button.

2. Select yourself and the directory objects that you want to include on the voice 
conference session from the Directory.

3. Click on the Voice Conference icon or right-click and select Voice Conference 
from the drop-down menu. 

Figure 7-2  
7Starting Voice conferencing

Connecting for the First Time
Voice conferencing is delivered out-of-the-box with the default setting of Push To 
Talk. If you are connecting for the first time you will receive the message ‘The push 
to talk feature requires you specify a hotkey.’ Refer to Figure 7-3.

Voice Conference 
Icon

Conference 
Button

Voice Conference 
drop-down
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Starting Voice Conferencing
Figure 7-3  
7Push to Talk Message

To complete your connection do the following:

1. Click OK.

2. Select Options from the e/pop Voice participant menu.

3. Select the ‘Hotkey’ preference in the General tab and specify the hotkey to be 
used with Push to Talk. The HotKey specifies the key that enables talking during 
the voice conference. e/pop voice conferencing is delivered with two options in 
the ‘Hotkey:’ input box. Place the cursor in the input box and select a keyboard 
or mouse hotkey.

Note:   You can select any key for this option.

Figure 7-4  
7Push to Talk Hotkey

Inviting Users
To invite users into an voice conferencing session, do the following before starting 
the voice conference application:

• Select users from the Directory

When a voice conference session has already been initiated a participant can join by 
manually executing Voice conferencing from his/her client computer from the 
Windows tool bar:

• Click Start > Programs > e/pop > e/pop voice conference
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Expelling Users
To expel a user from an voice conferencing session, do the following:

1. Select a user in the Voice participants window.

2. Click the File > Kick button on the e/pop voice tool bar.

The e/pop Voice Participant Menu
The Voice participant menu is the main menu of the voice conferencing session.  The 
menu will pop up on each invited participant’s computer monitor.

The tools and features available on the e/pop voice participant menu give you the 
flexibility to add and remove connections, expel participants, and many more 
options. Refer to Table 7-2 for a brief description of the available tools and features 
of the Voice participant menu (refer to Figure 7-6 for the features on the File drop 
down menu).

Figure 7-5  
7Voice Participant Menu

File Drop-down options

Hosting voice session

Participants

Added connections

Added Channel
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The e/pop Voice Participant Menu
Table 7-1  
Voice Participant options

File Window

Click on the File  button on the voice participant menu to see the additional 
options available (see Figure 7-6). The following selections respond with a new 
menu, which delivers information or requires input.

• Command & Control
• Add Connection
• Add Channel
• Properties

Button Description

File: tools available during the voice conference:
• Command & Control - Use to set up a combination of 

hotkeys and commands to use during a session.
• Add Connection - (see Add Connection below)
• Host Connection - Opens and closes host connection
• Mute - Turn off or pause audio
• Kick - Expel a participant
• Add Channel (see Add Channel below)
• Delete - delete connection or participant
• Properties - Connection window with status of 

current address of server and password if assigned.
• Loopback Mode - Used to test sound on your local 

computer.

Voice Conferencing Options: See Table 7-2 for a list 
of set up options available with voice conferencing.

Add Connection: Connection window to:
• specify address of a new remote server, or
• specify connection password to server. 

Disconnect: Disconnects from conference.

Add Channel: Add one or more channels to the 
session.

Server: OFF/ON - toggles server operation for voice 
conference hosting.
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The e/pop Voice Participant Menu
Figure 7-6  
7File Drop-down tools

Command & Control
The command and control option is used to set up a combination of hotkeys and 
commands to use during a session. Select File > Command & Control.

1. Click on the Add button and  is invoked with a button icon.

2. Click in the Editbox under HotKey and select a key (for example, F1 or space) 
from your keyboard.

3. Click in the space under Action, select the action to be associated with the 
hotkey from the drop-down list (for example, ‘when pressed, toggle listening on 
channel’).

4. Click in the space under Value, enter the value (for example, name of channel).
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The e/pop Voice Participant Menu
Figure 7-7  
7Command & Control 

Add Connection
The connection menu is used to specify the address of a new remote server and 
specify the server connection password.

Figure 7-8  
7Connection Menu

Add Channel
The add channel menu is used to add one or more channels to the session. Channels 
are used to create private voice sessions for a group or groups of participants during 
a voice channel session.
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Customizing Voice Conferencing
Figure 7-9  
7Add Channel menu

Properties
The connection menu shows the IP address of the remote server hosting the voice 
session.

Figure 7-10  
7Properties Option

Customizing Voice Conferencing
This section describes using options to customize voice conferencing in e/pop. 
Figure 7-11 shows the Voice options menu and Table 7-3 gives a brief description of 
each option tab.

Figure 7-11  
7Voice Options
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Customizing Voice Conferencing
Table 7-2  
Voice Options

Options Tab Preferences Description

General Identity

Transmit

Hotkey

• You can change your identity that other 
participants will see during the session

• Select Push to Talk (default) or Voice 
Activated

• Enter HotKey when using Push to Talk

Preferences Preferences
Users
Activation

• Operational preferences
• Show user statistics (version & packet loss)
• Adjust voice activation sensitivity

Audio DirectX
Recording
Playback

• Select audio option DirectX or Wave 
• Specify recording device
• Specify playback device

Volume Levels
Microphone

• Adjust volume of speakers
• Adjust recording volume

Speech Preferences

Speech
Playback

• Options for speaking user’s identity during 
connect/disconnect

• Options for computer generated voice
• Specify alternative playback device 

Proxy Preferences Specify for operating behind a gateway, proxy, 
firewall, etc.

Other Adapter
Special

• Specify alternative network adapter
• Unique settings for older 

software/hardware

Note:  Use this section if you have multiple 
cards

Channels Channels Add, Delete and Edit channels created to 
provide private group communication

Server Password

Compress

• Specify password required for connecting 
to and administration of the server

• Select compression level for voice 
communication
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Selecting Options for Voice Conferencing
The following voice option menus contain the out-of-box default options.

General Options Tab 7The settings in the general tab allow you to change the 
identity displayed to the other participants during the voice conferencing session. 
You can also change the transmission selection from Push to Talk to Voice Activated 
if your computer is equipped.

Figure 7-12  
7General options tab

The HotKey specifies the key that enables talking during the voice conference. 
Place the cursor in the input box and select a keyboard or mouse hotkey.
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Preferences Options Tab 7The settings in the preferences tab allow you to 
customize your operational preferences while running voice conferencing. 

• Always activate the server upon startup - starts the e/pop voice conferencing server 
when your e/pop voice is started.

• Always minimize on startup - e/pop voice conferencing is minimized to the tray, 
ready to be used.

• Play connect sounds - Default, when new users connect your selected sounds will 
play (see “Sounds Options” in Chapter 8).

• Play microphone click sounds - When you talk a ‘clicking’ sound will be heard by 
the other participants.

• Automatically reconnect - Default, set the time to reconnect to the session.

Figure 7-13  
7Preferences options tab

The 'Users' selection gives you the capability to view the statistic's of each user 
during the voice conference. 'Show Version' gives the version of e/pop being used 
and the 'Show pack loss statistics' indicates the amount of voice transmission is 
being dropped. 
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Selecting Options for Voice Conferencing
‘Activation’ selection is to adjust the level or sensitivity of the microphone. If you 
speak softly or have a loud voice, adjust accordingly.

Audio options tab 7Specify whether audio uses DirectX or the Windows 
preferred wave device. Select the Recording/playback sound device for your 
machine.

Note:   If DirectX for audio input is grayed out DirectX is not installed on your PC.

Figure 7-14  
7Audio options tab
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Volume options tab 7Use to adjust the volume of the speakers and adjust the 
audio volume of the microphone.

Figure 7-15  
7Volume options tab
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Speech options tab 7Use the options in the ‘Preferences’ selection to disable 
the speech features or speak the identity when connecting and disconnecting. The 
‘Speech’ selection is used to specify the gender of the computer generated voice. If 
you have more than one playback device installed use ‘Playback’ to select the 
alternative device.

Figure 7-16  
7Speech options tab
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Proxy options tab 7Specify options when operating behind a gateway, proxy, 
firewall, etc.

Figure 7-17  
7Proxy options tab
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Other options tab 7Use this section if you have multiple network cards 
installed in your computer and have older sound cards or have a low speed 
connection.

Figure 7-18  
7Other options tab
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Channels options tab 7e/pop gives you the flexibility to break up a voice 
conference into channels. Channels can be used to divide a large group on a voice 
conference into smaller groups. Each channel can communicate at the same time but 
only be heard in his/her channel.

Figure 7-19  
7Channels options tab
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Server options tab 7When setting up the e/pop voice conferencing server you 
can protect the session with a password. If someone wishes to join the voice 
conference he/she will need the password.

An administrative password can also be set to limit access to options.

Figure 7-20  
7Server options tab

The ‘Compress’ selections determine the compression used when data is transmitted 
across the network.

• High Compression (4.8kbps) - 
• Medium Compression (13kbps) - Default.
• Low Compression (32kbps) LANs only - 
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Chapter 8: Customizing With Options
Overview
This chapter describes using Options to customize e/pop.  The options allow you to 
control the various operating aspects of the e/pop program.  Some of these settings 
include the fonts, sounds and preferences that the program uses.  Figure 8-1 
illustrates the tab options available in the Options menu. 

Figure 8-1  
8Options

Network Options
Use Network options to specify the default protocol for e/pop and the active 
networks (refer to Figure 8-2).

The ‘Protocol’ Selection 8e/pop can use either IPX or IP protocol to 
communicate over the network.  Certain features such as application sharing and 
remote control require the IP protocol.  It is recommended you use the IP protocol if 
your network is already configured for IP.

Protocol Status LEDs 8The protocol status LEDs indicate the state of the 
various protocol-related capabilities of e/pop.  It is not unusual for certain settings to 
be yellow, depending upon the configuration of the network.  If any of the LEDs 
appear in red when communicating, then a mis-configuration exists in your protocol 
configuration on the computer.

Depending upon whether you select directed broadcasting or multicasting, the 
multicasting LED appears in yellow at all times.
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Network Options
Figure 8-2  
8Network options

The ‘Networks’ Selection 8The networks check boxes allow you to control 
whether e/pop uses a particular network.  By removing the check next to the 
respective network, you remove support for that particular network from e/pop.

Advanced protocol 8The advanced protocol options allow you to change the 
protocol behavior of the computer.  By default, e/pop is configured to use directed 
broadcasting to the local area network indicated by the number 255.255.255.255 for 
IP, and FF.FF.FF.FF.FF.FF for IPX (refer to Figure 8-3).
8-2 e/pop™ User Guide



Chapter 8 – Customizing With Options
Network Options
Figure 8-3  
8Advanced Protocol 
Options

Use the Advanced options for setting protocol if:

• Your network spans two or more physical locations
• Your network is separated by routers
• There is more than one network card or dialup adapter in your computer.

Specifying Remote Subnets and Wide Area Networks 8To traverse a 
wide area network, specify the remote broadcast subnet addresses of the remote 
networks.  If you are unfamiliar with the subnet addressing of your particular 
network, contact your wide area network manager.  Remote subnets usually are in 
the form of the IP address range of the network, combined with the masking for the 
network.  For instance, if the remote network’s address range is 10.5.2.1 through 
10.5.2.254, and its subnet mask is 255.255.255.0, then the broadcast subnet value 
that you enter into e/pop’s advanced protocol options is 10.5.2.255.  Repeat this 
procedure for each subnetwork.

Note:   The broadcast subnet is not the same as a subnet mask.  Your router must 
support directed or limited broadcasts over its ports.
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Network Options
These addresses can be provided to e/pop using three different approaches.  You can 
provide them manually, as indicated above, embed them into the e/pop application 
using the e/pop control panel, or use the command line switches:

• /BROADADDR+=
• /BROADADDR-=
• /FILE=

We recommend creating a centralized text file on your server that contains all the 
subnet addresses in the format required by the /FILE= command line switch.  (Refer 
to command line switches on the WiredRed Web site for more details.)

Multi-casting 8e/pop supports multi-casting instead of directed broadcasting in 
the event that all your switches, hubs and routers support multi-casting.  Contact 
your network manager for details on using multi-casting on your network.

Multiple Network Cards 8In the event your computer has more than one 
network card or more than a single route for TCP/IP, it might be necessary to 
instruct e/pop to use one card or route over the other.  Place a check in the box 
('Specify an alternative interface or network…') and type the IP address of the 
network or the static address you want e/pop to use.
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My Identity Options
My Identity Options
My Identity is your unique name that is used for display in the e/pop directory, 
including any workgroups your identity is to be displayed.

Identity 8Specify the identity or name you want displayed to other e/pop users in 
the Directory.

Workgroups 8Specify one or more workgroups where your identity is 
advertised to other users.

Figure 8-4  
8My Identity Options

The User’s network provides workgroup objects that can be controlled by the users 
of e/pop.  Workgroups allow users to organize themselves by departments or roles in 
an organization.

When you add, modify or delete a workgroup, e/pop informs all users and displays 
it in the directory. 
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Contact Options
Contact Options
Specify your personal contact information to be displayed to other users of e/pop.

• Enter your Phone or extension number
• Enter your E-mail address (for offline message delivery)

Figure 8-5  
8Contact options
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General Options
General Options
General Options include startup preferences and exit confirmations. Enable or 
disable each of the following:

• Run when Windows starts (Default) - e/pop starts each time you start Windows 
• Startup minimized in tray - e/pop minimizes into the system tray when you start it
• Display splash screen (Default) - e/pop displays splash screen when you start it.
• Use English language settings 

Figure 8-6  
8General Options

Exit confirmations 8Select one of the following:

• Always Ask - e/pop displays a confirmation message when you exit the program 
from the close button (Default).

• Always Exit - e/pop does not display a confirmation message when you exit the 
program.

• Always Minimize - e/pop always minimizes to the system tray when you attempt 
to exit the program from the close button.
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Status Options
Status Options
The Status options determine what status detail information is displayed within the 
Directory. Enable or disable these options as desired:

• Always show user details - Displays all user information including login, identity 
and machine name.

• Always show contact information for users - Displays the user’s phone extension 
and e-mail address. 

• Always show time stamp - Displays the time stamp of the last status change for 
the user.

Figure 8-7  
8Status Options

Advertise 8The advertise feature of status determines the response time of 
status-related information when it is requested from another user of e/pop.  
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History Options
History Options
Use the History options if you want to store a history of messages. By default, this 
option is enabled and e/pop stores all messages in the Inbox, Sent and Deleted 
folders. 

Deleting stored items 8Select one of these options for deleting items in the 
Inbox, Sent and Deleted folders. 

• Always Ask - e/pop displays a confirmation message.
• Always Delete- e/pop deletes without a confirmation message.
• Never Delete - e/pop does not allow you to delete item.
• Show delete button on the tool bar - by default this item is disabled. If you enable 

this option, the delete button will appear when selecting items in a history folder.

Figure 8-8  
8History Options
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Features Options
Features Options
Use Features options to enable or disable certain features of e/pop on your local 
installation or require a confirmation before allowing a feature to be performed on 
your computer.

Enabled 8To disable features remove the check next to a particular feature. You 
are removing the ability for the feature to be performed to your computer.

Confirmations 8By placing a check next to a feature, you can require a 
confirmation before a feature is performed on your computer.  This is useful in 
selecting features such as remote control, but not without first obtaining permission 
from the user. 

Figure 8-9  
8Features Options
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Message Options
Message Options
Use Message options to specify how e/pop displays new messages on your screen. 

Select one of the following (refer to Figure 8-10):

• Always show (default) - New messages always pop up on your screen.
• Always show inactive - New messages display in the Windows task bar. Only the 

subject of the message displays.
• Always prompt before showing - A prompt displays when you receive a new 

message, asking if you want to see it.
• Always hide - New messages arrive in your Inbox folder, but do not pop up on 

your screen.
• Flash when message arrives - The tray icon and message window will flash 

when a new message arrives.
• Show new messages when double clicking tray icon -New messages pop up on 

the screen when you double click on icon message in tray.
• Show new messages on top of other applications -New messages stay visible on 

top of other applications until you close the message window. 
• Retains return receipt button state - Allows e/pop to remember the state of the 

Return Receipt button from your last message. 
• Show auto reply message - Displays the auto reply message on the tool bar when 

activated.

Windowed 8Enable or disable the option desired:

• Single Window - All messages are displayed in a single window, with Previous 
and Next buttons to scroll through the most recent messages.

• Cascade Windows (default) -All messages are displayed in a separate window, 
overlapped on the screen.
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Chat Options
Figure 8-10  
8Message Options

Chat Options
Use Chat options to set display preferences when you are invited into a chat session 
or when a new message is posted to a chat session in which you are participating.

Select one of the following (refer to Figure 8-11):

• Always show - Chat window always pops up on your screen when you are 
invited into a chat session. (Default) 

• Always show inactive - Subject of chat session displays in your Windows task 
bar when you are invited into a chat session.

• Always prompt before show - A prompt displays when you are invited into a chat 
session asking if you want to display the chat window.

• Always hide - Nothing displays or prompts you if you are invited into a chat 
session.
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Chat Options
Messages 8Enable or disable the following:

• Flash when a new message arrives - Default, the tray icon and chat window flash 
when a new chat message arrives.

• Show a new chat session on top of other applications - Default, forces a new chat 
window to stay on top of other applications.

• Show date and time on chat messages - Displays date and time for all messages 
posted in a chat session.

• Show chat window for each chat message - Displays new window for each chat 
message received.

• Confirm close chat room when moderator leaves - Default, displays confirmation 
window before Chat session is closed.

Figure 8-11  
8Chat Options
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Fonts Options
Fonts Options
Use the Fonts option to specify the fonts used by messages, chat and the Directory window.

Figure 8-12  
8Fonts Options
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Sounds Options
Sounds Options
Use the Sounds option to specify audio alerts when you receive a new message or 
are invited into a chat session.

If you have an active sound card installed, e/pop plays the sound through the sound 
card.  An option for continuous play is available until the message is recognized by 
moving the mouse over the window, or typing into the active chat session.

Note:   In the event your computer is not equipped with a sound card, you can use 
the reserved word ‘BEEP’ to enable the PC speaker instead.

Select the following options as desired:

• Message - Plays the selected sound when a new message arrives.
• Chat Session - Plays selected sound when you are invited into a new chat 

session.
• Chat Message - Plays selected sound when a new chat message is posted in an 

active chat session.

Figure 8-13  
8Sounds Options
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Directory Options
Directory Options
Use Directory options to specify which feature (task) e/pop starts when you select a 
user or a group in the Directory. 

General 8Select a the general preferences for the directory. 

• Always sort the directory - When checked the directory is sorted when selected.

Feature 8Select a default feature to be used when double clicking on an object 
within the Directory.

Figure 8-14  
8Directory Options
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My Files Options
My Files Options
Use My Files options to specify the path to your personal history, shortcut and 
macros files.

The default installation directory for e/pop and your personal history file is the 
following:

C:\Program Files\Wiredred\Epop

Figure 8-15  
8My Files Options
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Do Not Disturb
Do Not Disturb
Use the Do Not Disturb options to control how messages and chat sessions are 
handled when you activate e/pop’s Do Not Disturb mode.  When you are in the Do 
Not Disturb mode, your user icon changes from green to yellow in the Directory so 
that other users can see you are busy or unavailable.

Chat windows 8Enable or disable the following:

• Hide new chat sessions - (Default) If enabled, new chat sessions do not pop up 
on your screen.

• Prevent chat sound from playing - If enabled, prevents any sound from playing 
when a chat message arrives or a new chat session is created.

Messages 8Enable or disable the following:

• Hide new messages - (Default) If enabled, new messages do not pop up on your 
screen.

• Prevent message sound from playing - If enabled, prevents any sound from 
playing when a message arrives.

Figure 8-16  
8Do Not Disturb Options
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Remote Control
Remote Control
Use the Remote Control options to specify whether or not the remote icon displays, 
to control access to the host computer keyboard and mouse, and to set up specific 
passwords for remote control.

Remote 8Enable or disable the following as desired:
• Hide the remote control icon - If disabled, remote control icon does not display in 

the system tray on the host computer while remote controlling.
• Never control remote keyboard - If enabled, prevents control of host computer’s 

keyboard.
• Never control remote mouse - If enabled, prevents control of host computer’s 

mouse.
• Always show the wallpaper - If enabled, prevents the wallpaper from displaying. 

This speeds up the remote control session.
• Refresh screen every <n> milliseconds. - If enabled, the host screen refreshes at 

the interval specified.

Security 8Enable or disable the following as desired:
• Always connect using the following password - Enter a password for controlling 

a host computer.
• Always require the following password - If enabled, a password is required before 

a user can remote control the computer.
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Remote Control
Figure 8-17  
8Remote Control Options
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AppShare
AppShare
Use the AppShare options to specify screen-refresh preferences during application 
sharing.

Enable or disable the following:

• Refresh screen every [ n ] milliseconds - If enabled, the host screen refreshes at 
the interval specified.

Figure 8-18  
8AppShare Options
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Locations
Locations
The Locations option allows you to specify preferences for your startup location.

Location 8Specify whether the location is automatic or prompted on startup.

• Always prompt for location at startup - Default, when enabled you will be asked 
to select a location at startup.

• Always use the following location at startup - The location displayed in the pull-
down will be used.

Advanced 8Advanced preferences for locations and connecting to servers.

• Automatically use the detected server - Will attempt to detect any e/pop servers 
on the network if selected (Default).

Figure 8-19  
8Locations option tab
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